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Getting Started
Book Learning Objectives

�� Learn the inner workings of the World Wide Web and how web content is 

published and delivered.

�� Learn the key terms and common language of web developers.

�� Learn to use Adobe Dreamweaver to create web pages and websites.

�� Understand and write HTML using Dreamweaver’s tools to visualize, write, 

edit, and test your web pages.

�� Use modern web standards to lay out web pages and control their appearance 

with Cascading Style Sheets (CSS) and make them accessible for all visitors to 

your site.

�� Become proficient with the Dreamweaver interface and the tools used to 

insert and format text, hyperlinks, images, tables, and video files.

�� Use Dreamweaver to design web pages that look and work great on comput-

ers, tablets, and smartphones and that are accessible to all visitors.

�� Publish and update web pages to the World Wide Web.

�� Apply principles of design that lead to attractive, engaging, and effective user 

experiences for all visitors.

�� Learn how to work with clients to develop project plans that lead to success-

ful web projects.

Welcome to Learn Adobe Dreamweaver CC for Web Authoring, Second Edition! We use 

a combination of text and video to help you learn the basics of web programming 

with Adobe Dreamweaver CC along with other skills that you will need to get your 

first job in web design. Adobe Dreamweaver CC is a powerful program for working 

with the HTML, CSS, and JavaScript code that make up the modern web experi-

ence. Dreamweaver is widely used within the web design industry and by many 

company web production teams to manage website resources, taking advantage 

of its dynamic authoring environment to create great user experiences for their 

customers.

About This Book and Video
Learn Adobe Dreamweaver CC for Web Authoring was created by a team of expert 

instructors, writers, and editors with decades of experience in helping beginning 

learners get their start with the cool creative tools from Adobe Systems. Our aim 
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is not only to teach you the basics of the practice of web page design with Dream-

weaver, but to give you an introduction to the associated skills (like design prin-

ciples and project management) that you’ll need for your first job.

We’ve built the training around the objectives for the Web Authoring Using Adobe 

Dreamweaver CC (2018) Adobe Certified Associate (ACA) Exam, and if you mas-

ter the topics covered in this book and videos, you’ll be in good shape to take the 

exam. But even if certification isn’t your goal, you’ll still find that this training will 

give you an excellent foundation for your future work in web design. To that end, 

we’ve structured the material in the order that makes most sense for beginning 

learners (as determined by experienced classroom teachers), rather than following 

the more arbitrary grouping of topics in the ACA objectives.

To aid you in your quest, we’ve created a unique learning system that uses video 

and text in partnership. You’ll experience this partnership in action in the Web Edi-

tion, which lives on your Account page at peachpit.com. The Web Edition contains 

10 hours of video—the heart of the training—embedded in an online ebook that 

supports the video training and provides background material. The ebook material 

is also available separately for offline reading as a printed book or as an ebook in 

a variety of formats. The Web Edition also includes hundreds of interactive review 

questions you can use to evaluate your progress. Purchase of the book in any format 

entitles you to free access to the Web Edition (instructions for accessing it follow 

later in this section).

Most chapters provide step-by-step instructions for creating a specific project or 

learning a specific technique. Many chapters include several optional tasks that 

let you further explore the features you’ve already learned. Two valuable chap-

ters acquaint you with other skills and concepts that you’ll come to depend on as 

you use the software in your everyday work. Here is where you’ll find coverage of 

Domains 1 and 2 of the ACA objectives, which don’t specifically relate to features of 

Dreamweaver but are important components of the complete skill set that the ACA 

exam seeks to evaluate. Because these chapters aren’t part of the path to learning 

Dreamweaver itself, they aren’t included in the printed book. They’re included in 

the ebook editions and in the online Web Edition (to access the free Web Edition, 

see pages xii–xiii).

Each chapter opens with two lists of objectives. One list lays out the learning objec-

tives: the specific tasks you’ll learn in the chapter. The second list shows the ACA 

exam objectives that are covered in the chapter. A table at the end of the book 

guides you to coverage of all the exam objectives in the book or video.

﻿﻿  ix
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Conventions Used in this Book
This book uses several elements styled in ways to help you as you work through 

the projects.

Links to videos that cover the topics in depth appear in the margins.

Text that you should enter appears in bold, such as:

In the Link field in the Property inspector, type  

http://www.capesnbabes.com.

Terms that are defined in the glossary appear in bold and in color, such as:

The web font that’s used in the header of the page is just what the client is 

looking for. That’s a great thing.

The ACA objectives covered in the chapters are called out in the margins beside the 

sections that address them.

Notes give additional information about a topic. The information they contain is 

not essential to accomplishing a task but provide a more in-depth understanding of 

the topic:

NOTE  
The default behavior for background images is to tile across and down the 
container where they are set.

Working in Dreamweaver means you’ll be working with code. We have used sev-

eral conventions to make working with the code in this book easier to follow and 

understand.

In many instructions, you will be required to enter HTML code, CSS rules, and 

properties and other code-based markup. To distinguish the markup from the 

instructional text, the entries will be styled with a code font, like this:

Examine the code <h1>Heading goes here</h1>.

In instances where you must enter the markup yourself, the entry will be formatted 

in bold, like this:

Type the following code: <h1>Heading goes here</h1>.

Within the body of descriptions and exercise instructions, elements may be ref-

erenced by name or by class or ID attribute. When an element is identified by its 

tag name, it will appear as <h1> or h1. When referenced by its class attribute, the 

name will appear with a leading period (.) in code font, like this: .content or 

.sidebar1. References to elements by their ID attribute will appear with a leading 

	Video 9.5  About 
Copyright

  ACA Objective 2.1
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hash (#) and in a code font, like this: #top. This practice matches the way these ele-

ments appear in the Tag selector interface in Dreamweaver.

OPERATING SYSTEM DIFFERENCES

In most cases, Dreamweaver CC works the same in both Windows and macOS. 

Minor differences exist between the two versions, mostly due to platform-specific 

issues. Most of these are simply differences in keyboard shortcuts, how dialogs are 

displayed, and how buttons are named. In most cases, screenshots were made in 

the Windows version of Dreamweaver and may appear somewhat differently on 

your own screen.

Where specific commands differ, they are noted within the text. Windows 

commands are listed first, followed by the macOS equivalent, such as Ctrl+C/

Command+C. In general, the Windows Ctrl key is equivalent to the Command 

(or Cmd) key in macOS, and the Windows Alt key is equivalent to the Option 

(or Opt) key in macOS.

As chapters advance, instructions may be truncated or shortened to save space, with 

the assumption that you picked up the essential concepts earlier in the chapter. 

For example, at the beginning of a chapter you may be instructed to “press Ctrl+C/

Command+C.” Later, you may be told to “copy” text or a code element. These 

should be considered identical instructions.

If you find you have difficulties in any particular task, review earlier steps or exer-

cises in that chapter. In some cases when an exercise is based on concepts covered 

earlier, you will be referred back to the specific chapter.

Installing the Software
Before you begin using Learn Adobe Dreamweaver CC for Web Authoring, make 

sure that your system is set up correctly and that you’ve installed the proper soft-

ware and hardware. This material is based on the original 2018 release of Adobe 

Dreamweaver CC (version 18.1) and is designed to cover the objectives of the 

Adobe Certified Associate Exam for that version of the software.

The Adobe Dreamweaver CC software is not included with this book; it is avail-

able only with an Adobe Creative Cloud membership, which you must purchase 

or which must be supplied by your school or another organization. In addition 

to Adobe Dreamweaver CC, some lessons in this book have steps that can be per-

formed with Adobe Photoshop. You must install this application from Adobe 

Creative Cloud onto your computer. Follow the instructions provided at  

helpx.adobe.com/creative-cloud/help/download-install-app.html. 

﻿﻿  xi
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CHAPTER OBJECTIVES

Chapter Learning Objectives
�� Understand how the client-to-design process 

works for creating page prototypes that 
meet the customer’s requirements.

�� Create CSS styling rules that make use of 
background images.

�� Use round-trip editing to insert a source 
Photoshop image file and edit the file from 
within Adobe Dreamweaver.

�� Insert images on a web page and position 
them using CSS floats.

�� Learn the location and purpose of 
Dreamweaver’s image editing tools and the 
recommended methods for their use.

�� Use Dreamweaver’s visualization tools to 
troubleshoot designs and align elements on 
the page.

Chapter ACA Objectives
For full descriptions of objectives,  
see the table on pages 258–264.

DOMAIN 1.0    
WORKING IN THE WEB INDUSTRY

1.1, 1.2, 1.3, 1.5

DOMAIN 2.0   
PROJECT SETUP AND INTERFACE

2.1, 2.3, 2.4

DOMAIN 4.0   
WORKING WITH CODE TO CREATE  
AND MODIFY CONTENT

4.1, 4.2, 4.3



CHAPTER 4

Getting the Big Picture
Human beings are incredibly visual creatures. Our brains can process 

more information when we view a picture or illustration than we can 

by reading a long passage of text. The old saying “a picture is worth a 

thousand words” is certainly true.

Images and visuals are a huge part of the modern web experience, and in 

a world in which you can snap a photo on your phone and instantly pub-

lish it online, visitors to a web page expect to see lots of images. And just 

like graphics, images can be used to define the layout of web pages and 

assist in the usability of the site, making it easier for visitors to find their 

way around and get to the information they’re after. Don’t forget to make 

your images accessible for visitors who cannot physically see your site.

In this chapter, you’ll take a look at how to use images to further define 

the look and feel of a design, how to insert and position images, and the 

tools that Dreamweaver provides to help you get those jobs done.
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Bring On the Art!
Great news! Your client Chris the Cartoonist (Figure 4.1) has provided a ton of 

artwork for the WULVS.info website, and he’s also given you excellent guidance on 

how he wants the design to proceed.

From Chris:

I really like the layout of the page! Those colors are kind of weird, but I know that’s just 

temporary, right? Let me tell you a little more about the storyline and the characters in my 

made-up world.

WULVS is a comic strip built around a security service run by Ray the Werewolf.

In Ray’s world, he works with a group of vampires, zombies, witches, mummies, aliens, 

and other characters who work as guards for hire by the “regular” humans of the world.

Part of the fun of the comic strip is how Ray runs his business—and his website—just like 

a regular business. After all, a monster has to make a living too. What I want to do is use 

the artwork of the characters in the strip to create Ray’s company website, wulvs.info.

I’m going to break down what I want for each page and put it into a separate document. 

OK? I’m looking forward to seeing your work!

Lucky for you, he’s happy with the layout that was made from the wireframes in 

the last chapter. Now you can take the big step of designing the pages the way 

Chris wants. Well, he isn’t sure exactly what he wants quite yet, but that just means 

you can put on your designer hat and start working on a prototype for this site.

To get started on all the new elements for this design, you’ll need to download the 

files that have been provided and define your Chapter 4 website.

Get Your Files Here
As you did in previous chapters, copy the folder that contains this chapter’s files to 

your computer.

1	 Download the project files for this lesson, named chapter-04.zip, from the 

Lesson & Update Files tab on your Account page at www.peachpit.com, and 

store them on your computer in a convenient location.

2	 Unzip the files and copy the chapter-04 folder to the Learn-Dreamweaver 

folder you created in Chapter 1.

Figure 4.1  Chris
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Define the Chapter 4 Website
With the files you’ve been provided for this chapter in the project folder, you’re 

ready to set up the site in Dreamweaver.

1	 From the application bar, select Site > New Site.

2	 Name the site Chapter 4.

3	 Browse to the chapter-04 folder in your Learn-Dreamweaver project 

folder.

4	 Click Save.

Image File Formats for the Web
Deciding on the right kind of image to include in a web page goes beyond sim-

ply getting the best picture available and sticking it on a page—although making 

that choice can be a huge chore in itself. You also need to understand which types 

of files will be displayed properly by the viewer’s browser and which type is most 

appropriate for the kind of image you are adding.

At the most basic level, it’s pretty simple. Web browsers can display three file types:

�� GIF (Graphics Interchange Format) images have filenames that end with the 

.gif file extension. GIFs can display a limited number of colors, which makes 

them very efficient. GIFs are a great choice for graphics—such as logos, illus-

trations, navigation bars, and other design elements—that don’t require 

colors with subtle shades. GIFs can have a transparent background, and of 

course you can animate GIFs to create miniature movies. How else would we 

be able to see cats playing pianos?

�� JPEG (Joint Photographic Experts Group) files use the .jpg or .jpeg exten-

sion, and as you can probably guess, this format is best used for photographs 

and other images with thousands or millions of colors. JPEG images can be 

compressed by changing quality settings in an image editor to get smaller 

file sizes. Web designers often compare different quality settings in Photo-

shop, for instance, until they achieve a good balance between how good the 

image looks and its file size. JPEGs cannot have transparent areas and cannot 

be animated.

  ACA Objective 2.1

NOTE  
Refer to Video 1.10, 

“Defining a Site,” if you 
want a quick demo of 
how the site definition 
process works.

  ACA Objective 2.4
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�� PNG (Portable Network Graphics) was specifically developed for use on the 

web. The cartoon character images you’ve been provided all use the PNG 

format because images in this format can display transparency, sharp edges, 

and color changes—like a GIF—but still allow for subtle shades of colors like 

a JPEG. PNG files are by far the most common file type used by modern web 

designers.

All these file types are in the family of images known as bitmaps. In a bitmap, every 

color in the image is defined as a tiny block of data with a color value and other 

properties. If you’ve ever zoomed way in on a digital image, you’ve seen those indi-

vidual blocks magnified and seen how the image is composed.

Every image in a web page must be downloaded from a remote server somewhere, 

which makes image file weight—the size of the file as measured by how much 

data it holds—almost as important as how it looks. Large image files are one of the 

primary culprits when a page loads slowly—for example, inserting an image that 

weighs 500 KB versus one that weighs 100 KB.

This process of choosing the right file type and adjusting image properties (to get a 

small file size that still looks good) is known as optimization. Adobe makes Photo-

shop for editing and optimizing images. The best method for working with images 

is to compose and edit the images in a graphics editor and then export a version 

that has been optimized for viewing on the web.

Whether or not you’re optimizing your images or you’re working with a graphic 

designer who will prepare the images while you take on the coding duties, you do 

need to know the kind of images that are appropriate for different applications. 

Smart designers always work with a source Photoshop file and never work directly 

on an image file or photograph without having a backup.
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PROJECT 4.1

Prototyping and Designing 
with Background Images
Chris has been hard at work and has provided all sorts of new information to work 

with. In the project files for Chapter 4, Chris has supplied a bunch of images and 

specific feedback on how things should look going forward. Based on the instruc-

tions and the materials he has provided, you can start getting content into place.

Examining Client Feedback and Requirements
Take a few moments to familiarize yourself with the new files and folders that Chris 

provided.

1	 Open Dreamweaver and review the structure of the site and the new folders 

and images.

The folders and files you created in Chapter 3 are still in place, but new 

images and documents have been supplied by the client (Figure 4.2). The 

images folder contains lots of new cartoon characters, and the source folder 

contains Photoshop files. Also included are two client feedback files.

Photoshop files  
in source folder

Prototype  
web page

Client feedback 
document

Chapter 4  
site selected

2	 Open client-feedback.docx by double-clicking the file in Dreamweaver.

The file opens in Microsoft Word (if that application is installed on your com-

puter). If you don’t have Word installed on your computer, you can open the 

client-feedback.rtf file in almost any word processor.

  ACA Objective 1.1

  ACA Objective 1.2

  ACA Objective 1.5

  ACA Objective 2.4

  ACA Objective 4.3

	Video 4.1  Client 
Feedback

	Video 4.2   
Prototyping and 
Faux Column Layout

	Video 4.3   
Designing with 
Background Images

Figure 4.2  The files 
and folders for the 
Chapter 4  website
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3	 Read through the client feedback from the client.

Deciphering information from a client frequently involves a lot of detective 

work. What specific guidance does the client provide? What things are being 

left up to you as the designer? And most importantly at this stage, can you 

determine enough information to get a feel for how things should look?

4	 Open the client’s design comp by double-clicking wulvs-comp.png.

This file opens in the default graphics editor on your computer (Figure 4.3).

The design comp includes the major design elements that the client is 

requesting. The page is centered in the viewport and has a header, sidebar, 

footer, and main content area. You’ll also see design clues as to how the client 

wants images to be used. This is another good time to jot down some notes 

on what you discover in this document.

Figure 4.3  Major design 
elements in the design 
comp provided by the 
client

Header with 
character collage

Character inserted 
into the page

Page background  
with textured image

Sidebar and 
navigation area

5	 Now open index.html.

This is the same file that you finished at the end of Chapter 3. Compare this 

file to the client’s composition and you will see many differences (for exam-

ple, the background colors differ and there are no images).

6	 Open prototype.html.
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This is a file that you might have developed based on your detective work of 

the information your client provided. In the interest of time, the following 

tasks have been done for you:

�� The document includes the content that will appear in several pages of 

the website. You’ll find new Heading 1 tag sections for the Team, Services, 

Rates, and Contact pages.

�� The Team section has character descriptions, the Services and Rates sec-

tions have tables of information, and the Contact section has a spot for 

a form.

�� The sidebar area has text for two navigation sections and placeholder text 

for where advertising might go.

�� New CSS styling rules have been created to assign background colors and 

borders to the header and footer areas of the page.

7	 Open the CSS Designer panel. Select the Show Set check box in the upper-

right corner of the panel, and examine the properties that have been applied 

to the #header and #footer rules in this document.

Once you’ve thoroughly reviewed all the changes that have been made and com-

pared those changes to the index.html file, you are ready to move on to more 

styling. You can even close index.html. All the work you do from this point for-

ward will be done in prototype.html.

Prototyping in Web Design
Working with a technical prototype is a very common method used by designers 

as they reach this stage in designing a website. By using a single document like the 

one you’ll work on in this chapter, all the individual images, text, tables, and other 

elements can be placed and styled into a single page. The CSS styling rules remain 

in the <head> of the page while this work is going on, making it easier to keep 

track of the rules as you create, troubleshoot, and modify styles. When the styling 

is complete and the client has given final approval to move forward, the CSS file 

will be converted into a separate, external file, and the contents of each section can 

be copied to the pages where they’ll ultimately reside.

This kind of workflow also allows you as the designer to take advantage of Dream-

weaver’s automation features as final designs are converted to templates and library 

items. These templates and library items make it easier to generate new pages and 

update an entire site full of web pages when a revision takes place.
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LEVEL UP: SMART WORKFLOW

One of the best habits you can have as a web designer is to incrementally 
back up your files as you work. Throughout the course of this chapter, 
you’ll be working on a single file: prototype.html. You should save a 
version of the file as you achieve each milestone in the design process. 
To do this, select File > Save As to make a copy of the file as you go along. 
For instance, at the conclusion of this project you might save this file as 
prototype-project-4-1-complete.html. You’ll continue to work on 
prototype.html, but if some tragic mishap occurs you can open a previ-
ous version of the file to recover your work.

Using the Faux Column Technique 
to Style the Sidebar
The client’s design calls for a sidebar to extend down the left side of the page. That’s 

a very common arrangement, but it presents a challenge: How does a web designer 

style this area of the page in such a way that it appears correctly no matter how 

long the web page is? Let’s understand the problem, then see a common solution.

1	 With prototype.html open, place Dreamweaver in Design view. From the 

application bar, choose View > Design View Options > Visual Aids > CSS 

Layout Backgrounds. You can enable and disable this view as you examine 

the page.

Dreamweaver will apply color coding to help you visualize the <div> 

elements of the page (Figure 4.4).

Figure 4.4  The Design 
window with CSS Layout 
Backgrounds enabled

Sidebar content 
does not extend 

down the page
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Notice that the main area content is longer than the sidebar content. You 

could insert your cursor into the sidebar and press Enter/Return to add a 

bunch of empty paragraphs until the sidebar is as full as the content area, 

but that’s a very sloppy way to deal with the issue. It will also generate many 

problems when you view the page on different devices (such as smartphones 

and tablets). Instead, you will use a time-tested method of styling with a back-

ground image. This method is known as the faux column technique.

2	 Double-click the container-bg-gold.png file inside the images folder to 

open it.

The faux column technique is perfect for a fixed-width page like the one 

you’re working on. Alternative approaches are needed when working with 

responsive designs for mobile devices. To create the illusion that the left 

column is filled up, a background image that matches the width of the con-

tainer is used for the background. In this case, the #container <div> is set 

at 960 pixels wide.

The #sidebar <div> is 180 pixels wide. The area of the image that will pro-

vide the background color or pattern needs to be set to a matching width. 

Figure 4.5 details how this image is laid out.

Image matches the width of 
the container div: 960 pixels

The “column” area of the image 
is set to 180 pixels wide to 
match the sidebar width.

Notice that the image is only 20 pixels high. A background image like this 

one doesn’t need to be any larger, because it will repeat vertically inside its 

container.

3	 Open the CSS Designer panel, and select the #container selector.

4	 In the Background section, locate the background-image property and click 

the Browse for File icon to locate the image.

5	 Browse to the chapter-04/images folder and select container-bg- 
gold.png. Click OK/Open to set the image as the background.

6	 To control how the image repeats, or tiles, down the container, set the 

background-repeat property to repeat-y. This will restrict the image to 

repeating only down the page and not across.

Figure 4.5  An image for 
use as a faux column

NOTE  
You’ll actually have to 
click the folder icon 
beside the URL field 
twice in many cases. 
This might be inten-
tional or just one of 
those little quirks that 
software programs 
sometimes have.
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7	 Compare your settings to Figure 4.6.

If everything looks good, it’s time to preview your work in your favorite web 

browser. Your prototype.html page should look similar to Figure 4.7 after 

you scroll down to the “Here’s what Wulvs can do for you!” heading.

#container 
selector active

background-repeat 
settings

Browse for File icon

Background category

Figure 4.6  The CSS 
Designer panel set to the 
Background category

Figure 4.7   
Prototype.html page 
viewed in browser (note 
that the sidebar appears 
throughout the left side  
of the web page).
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Using Images in Page Backgrounds
The second client request is for an image that displays on either side of the content 

area of the web page. Chris has provided several different images for you to try. You 

might not actually use these in the final design, but it’s a good opportunity to see 

the different background-repeat settings that CSS provides and to see how images 

may be used to style the entire visible window in a web browser display.

This process uses the same tools and techniques you just used on the #container 

selector, except this time you’ll work with the body selector.

1	 Open the CSS Designer panel, and select the body selector. This selector was 

created previously to “zero out” the page margins and to set a temporary 

background color.

2	 Click the Background category, and move your cursor over the background 

color setting, as you see in Figure 4.8.

You’ll see two buttons appear to the right: a button that allows you to disable 

a setting temporarily and a trash can icon for deleting a property.

body selector 
active

Background 
category

Figure 4.8  Background 
color settings in the CSS 
Designer panel

Delete property

Disable/Enable 
property

3	 Click the trash can icon to delete the background color setting.

Web designers frequently use tiny images set to repeat across and down the 

page to create a wallpaper effect.
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4	 Click the Browse icon next to the background-image url field.

5	 Browse to the chevron_bg.png file in the images folder. Select the file and 

click OK/Open.

The background-image setting will appear (Figure 4.9).

6	 Set the background-repeat option to tile across and down.

	

Repeat value to  
set tile (repeat)

Browse for 
image

Path to image

7	 Click the Real-time Preview button (   ) in the lower-right corner of the 

document window. When prompted, choose to save and view the file in your 

favorite browser.

You’ll see this one small image tile across and down the page (Figure 4.10).

	

Figure 4.9  Background 
images are tiled inside 
their container when set 
to repeat.

NOTE  
The default behavior for 
background images is 
to tile across and down 
the container where 
they are set. Although 
it isn’t necessarily 
required, if you want 
this default behavior 
it’s good practice to 
explicitly set that value.

Figure 4.10  The single 
chevron image repeats 
horizontally and vertically 
as the background for the 
body selector.
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8	 Click the Browse icon in the background-image settings area, and switch the 

file to diamond-bg.png. Again, preview your page in a browser to see tiled 

background images in action.

The design in Figure 4.11 might not make the final cut, but you should have 

a good idea of how this kind of image can be incorporated into a design.

	

Another common background image design technique is to use a wide image 

with gradients or other visual properties set on either side of a blank area of 

the canvas.

9	 Return to the Files panel. From the source folder, open gradient-bg.psd 

(a Photoshop file) (Figure 4.12).

Note that this image is quite wide—2200 pixels—but only 20 pixels high. 

You’ll also see that the center portion of the canvas has been filled with a 

white rectangle that matches the width of the #container <div>. 

10	Return to Dreamweaver and the CSS Designer panel, and use the Browse for 

File icon in the background-image setting to switch the background image to 

gradient-bg.png.

11	The background-position setting should be set to 50% and 0% to place this 

image in the center of the viewport. You can drag your mouse to apply this 

setting, or click inside the value field and type the value.

Figure 4.11  The single 
diamond image repeats 
horizontally and vertically 
as the background for the 
body selector.

TIP  
This approach will work 
only with static-sized 
web pages (and may 
not display properly on 
mobile devices). You 
will learn about alterna-
tive approaches in a 
future chapter.

Gradients on either side of 
the #container area

Rectangle matches  
container width

Figure 4.12  Background 
images are used in some 
designs to create a gradi-
ent border effect.
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12	Click the repeat-y icon in the background-repeat area, and compare your set-

tings to those in Figure 4.13.

	

Path to image

Background 
position 
centered

Background 
repeat set  
to repeat-y

When you preview the page in a browser or switch to Live view, you’ll see 

that the area on either side of the page contents has a gradient background 

that fades to white. This is another way the client’s requirements might be 

met using background images. Be aware that this may cause significant issues 

when working with responsive layouts, but it can be a quick approach to 

develop a prototype for a client (Figure 4.14).

	

Figure 4.13  Centering a 
background image that 
repeats vertically down 
the page

Figure 4.14  The effect of 
using a background image 
that repeats vertically 
down the page
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Using CSS Gradients in Page Backgrounds
In the past, it was standard practice to include background gradient images in web 

pages. Many sites you encounter today will still use these approaches. That is why 

it is important to know how to incorporate background images using Dreamweaver. 

With the advent of CSS3 support in modern browsers, CSS gradients are now 

widely used.

Let’s return to the body selector once again.

1	 Open the CSS Designer panel and select the body selector.

2	 Click the Background category and move your cursor over the background 

color setting, as you saw previously in Figure 4.8.

3	 Click the trash can icon to delete the background image setting.

4	 Set Dreamweaver to Split view and scroll to the top of the CSS definitions 

(just below the <style> tag). Locate the body selector.

5	 Modify the CSS code for the body selector so that it appears as shown here: 

body {

margin-left: 0px;

margin-top: 0px;

margin-right: 0px;

margin-bottom: 0px;

background:linear-gradient(to right, black, grey); 

}

6	 Save your work and preview it in a browser of your choosing. You result 

should be similar to what you see in Figure 4.15. 

	

NOTE  
You can also use the 
CSS Designer panel 
background tab to 
create gradients.

Figure 4.15  The effect of 
using a CSS gradient as a 
background
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In this project, you’ve learned how you can use background images as a layout 

technique where a column on the page is visually defined using a background 

image. You have also seen how the entire viewable area around the page contents 

can be styled by applying a background to the <body> tag.

LEVEL UP: YOUR OWN BACKGROUND IMAGES

Now that you know how to use background image settings, you can modify 
the properties of the CSS styling rule that is applied to the header area with 
the ID #header.

Select the #header rule in the CSS Designer panel, and apply one of the 
background header images the client has provided. 

Looks like Chris is still going with sort of a hipster vibe. The files named 
argyle-bg.png and diamond-bg.png are two examples you might use. 
Or you can work a background image into your own design comp and use 
your own file. 

Or you can employ a CSS gradient of your choosing. You can learn more 
about CSS gradients by searching for additional examples using your pre-
ferred search engine. You will discover many additional interesting effects 
you can employ with CSS gradients.
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PROJECT 4.2

Inserting and Editing Images
You accomplished a lot in the first project. You’ve gotten some important page ele-

ments all set using background images and CSS styling rules to style the content 

areas of the page. Did you take the Level Up challenge? If you did, your header 

should also have a nice background image applied to it.

Now it’s time to turn your attention to inserting images into the body of the page. 

Luckily for you, Chris has provided many images for you, and he’s even optimized 

them and set the file types of the images properly so you can jump right into insert-

ing the images. In this project, you’ll use the tools that Dreamweaver provides for 

working with images in a website, try the editing options that are available, and 

follow some recommended practices for modifying images.

From your review of the design comp and the instructions the client provided, you 

know you have a lot of images to insert into the page.

LEVEL UP: DREAMWEAVER PREFERENCES

Dreamweaver allows you to set numerous individual preference settings that 
determine how the software works for you. You can determine which brows-
ers you want to have available for previewing web pages, change the colors 
of your Code window, and set the font size used in the Code window, to 
name a few.

You can also set your preference for which image editor will open when you 
are using the image editing tools while working on a document.

1	 Open Dreamweaver preferences by choosing Edit > Preferences 
(Windows) or Dreamweaver CC > Preferences (macOS).

2	 Select the File Types/Editors category in the left column. You’ll see the 
three image file types available for use in web pages (GIF, JPEG, PNG), 
and you can select which editor to use.

3	 Choose the editor you wish to use in the right column and click Close.

Photoshop is by far the most popular editor to use and is the one most likely 
to appear on your computer if you have the Creative Cloud suite installed.

  ACA Objective 1.2

  ACA Objective 1.5

  ACA Objective 2.4

  ACA Objective 4.1

	Video 4.4  Image 
Preferences

	Video 4.5  Inserting 
Images Using the 
Assets Panel

	Video 4.6  Inserting 
Photoshop Source 
Files
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Insert an Image Using the Assets Panel
The Assets panel is a great tool for situations in which you have many available 

images and want to identify which ones to use.

1	 If the Assets panel is not already open, select Window > Assets. By default, the 

panel appears in the same panel group as the DOM and Snippets panels.

The Assets panel makes it easy to sort through all the images in your site and 

displays a preview of the images at the top of the panel. You can slide the 

divider up or down between the preview area and the alphabetical list of files 

to see a smaller or larger preview. Figure 4.16 shows the functional areas of 

this panel.

2	 Scroll through the images to locate ray.png and select it.

3	 Place your cursor in front of Ray’s introduction to the site (My name is Ray…) 

and click the Insert button in the Assets panel to place ray.png onto 

the page.

Images category

Selected image  
(ray.png)

Insert button

Preview area

Slide divider to change 
preview area size

Image dimensions

Scale and Size an Image
As soon as the image displays on the page (Figure 4.17), you can tell that you have 

a big problem. This image is way too large. 

When an image is selected, you’ll see a small, square resize handle appear in the 

image’s lower-right corner. You can scale the image by holding down the Shift key 

Figure 4.16  The Assets 
panel with the Images 
category selected
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while dragging this handle. Or you can click the lock icon in the Property inspec-

tor to lock the aspect ratio and keep the image set to the proper width and height 

dimensions as you drag.

1	 Click the image, and drag the image’s resize handle to what you think will be 

the proper dimensions for this image.

As you resize the image, dimensions will change in the Property inspector. 

Make note of those dimensions. We will need to change the size of the image 

in a photo editing program (such as Photoshop).

When you resize or scale an image in this manner, you are changing the 

width and height that the browser will use to display the image. The image 

itself is not changed in any way, and most importantly, the file size of the 

image is the same as always. Placing a large image onto the page and then set-

ting a smaller width and height is a waste of bandwidth (the very large image 

must download entirely in order to display the very small resized image). 

A smaller version of this image works much better in this case.

Figure 4.17  The Property 
inspector tools for setting 
image dimensions

Resize handles

File size Edit image in 
image editor

Display 
dimensions

Lock  
aspect ratio

Reset to 
original size
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2	 Undo your changes to the image so that it returns to its original size, or click 

the Reset to Original Size button in the Property inspector.

In the next steps, you’ll use a better method for editing an image that is too 

large for the page.

Duplicate and Edit an Image
Remember that smart designers never (ever!) destroy an original image. You might 

be tempted to open ray.png in Photoshop, change the image dimensions, save 

the file, and plunk the smaller version onto the page. But that kind of destructive 

process changes the file forever. You could never make the image larger again, and 

because you never really know how you might want to use this image in the future, 

it’s always better to keep the original file as it is and work from a duplicate of the 

file. The Adobe toolset makes this an easy process.

1	 Select the ray.png image (in the web page), and press the Delete key to 

remove it from the page. You will not be using this file for this location.

2	 Click the Files panel, and expand the images folder.

3	 Select ray.png. Right-click, and choose Edit > Duplicate from the context 

menu (Figure 4.18).

ray.png selected

Duplicate an existing 
file (Edit > Duplicate)

Notice the other basic file operations you can perform from the Edit menu.

Anytime you duplicate a file in this way, Dreamweaver automatically appends 

the name with – Copy. In this case, Dreamweaver will create a file named 

ray - Copy.png, which you’ll see listed in the Files panel.

Figure 4.18  The Files 
panel allows you to dupli-
cate files and perform 
other basic file operations.
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4	 Click twice—but not too fast—on the file named ray — Copy.png. The file-

name is highlighted in blue. Change the name of the file to ray-smaller.png.

This is the file you will use in your design, leaving the original image of Ray as 

it is, safe and sound.

5	 Drag the ray-smaller.png file from the Files panel, and drop it onto the 

page in front of the first sentence (“My name is Ray…”).

The image is at its original size, but now you can safely edit this image with-

out harming the original.

6	 With the image still selected in the page, click the Edit button in the Property 

inspector to open Photoshop (or the default image editor you set in Prefer-

ences). If the Property inspector is not open, from the menu select Window > 

Properties.

7	 Resize the image and save the changes you make in your image editor. In 

Photoshop, you can resize the image by choosing Image > Image Size. Set the 

image width to 90 pixels and save the file.

8	 Return to Dreamweaver and note the appearance of the image. It’s still too big 

(and it also now looks grainy). The Property inspector still shows the original 

dimensions. To set the dimensions to the new, correct dimensions, click the 

Reset to Original Size button in the Property inspector (Figure 4.19). Don’t 

forget to save your work.

New file size measurement Reset image to its original size

Notice that the image is displayed at the dimensions you set when working in your 

image editor. Also note the new file size of this image as shown in the Property 

inspector: only 34 Kb. You saved almost 60 Kb of unnecessary data that doesn’t 

have to be downloaded by a site visitor. You also saved bandwidth and made a 

backup of the original client artwork all at the same time. Good job!

Figure 4.19  Resizing 
an image in a graphics 
editor, such as Photoshop, 
reduces the file size of 
the image and saves on 
bandwidth.
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Dreamweaver’s Image Editing Tools
Dreamweaver includes tools in the Property inspector for editing images and per-

forming small adjustments directly in Dreamweaver. But be warned! These tools 

make permanent changes to the image once you save the Dreamweaver page you’re 

working on.

Figure 4.20 shows the location of these tools in the Property inspector. You can 

try these out for yourself, but be sure to choose Edit > Undo after you make each 

change so that the file you are using isn’t permanently altered.

A	 Crop Image displays a crop area. Use the crop area handles to set the size of 

the area to be cropped. Double-click to crop the image.

B	 Resample Image is used when you have changed the dimensions of an image 

and you want to improve its picture quality at its new size and shape.

C	 Brightness and Contrast is used to make small changes to how dark or light 

an image is and how sharply the colors in the image are defined.

D	 Sharpen adjusts the focus of an image by changing the contrast of pixel edges 

in the image.

A B C D

LEVEL UP: SMART FILE MANAGEMENT

You’re probably beginning to get a feel for just how complex a website can 
become and just how many files and folders there are to deal with. Remem-
ber that this is a very small website.

One file management method that most web designers use is to keep a 
separate folder within their site where they store all their original Photoshop 
source files. This might also be the location where files used in other creative 
tools, such as Adobe Animate CC, might be stored. These source files aren’t 
used in the actual HTML documents you create until a version of the source 
is published from the editor to a format that web browsers can display. But 
even though these files aren’t part of the final web page product, having 
them stored inside the main (root) folder for each site you create makes it 
easier to find them when it’s time to make edits and export for the web.

Figure 4.20  Image edit-
ing tools in Dreamweaver 
as seen in Design view
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Round-Trip Editing with Photoshop
Recall that at the beginning of this project you were told that smart designers 

always work from an original source file from Photoshop and never take actions 

that will destroy an original. However, web designers in particular never know 

where their artwork might come from or in what format. You might, for exam-

ple, have the freedom to work from an original composition that you create in 

Photoshop, using all your own art and photos to compose something entirely 

new. Photoshop has awesome tools that let you compose an entire page layout 

and design in one PSD file and export the images and CSS values for use in a web 

design project.

Web designers also have to work in a setting like the one you see here, where the 

client has provided artwork and instructions on how they should be used. Once 

you find that you need to modify an image in any way—changing its size, adding 

text, or even making color corrections to a photograph—you should create a source 

file so you can have a backup on hand in a format that lets you go back and make 

additional changes.

Dreamweaver provides a way to do this by allowing you to make round-trip edits 

from a source Photoshop file. Let’s see how that works.

1	 From the Files panel, expand the source folder and locate the file named 

ronni-original.psd.

2	 Drag the ronni-original.psd file onto the page at the end of the last 

bulleted sentence (just above the header “Team Page”). 

Dreamweaver will display the Image Opti-

mization window, where you’ll choose the 

appropriate image format for the file. For 

this file, you’ll continue to use PNG24 as 

the format to be saved.

3	 Click the dropdown arrow in the Preset 

field, and select the PNG24 option 

(Figure 4.21).

4	 Click OK to set the format, and Dream-

weaver will open an Explorer or Finder 

window so you can save the image into its 

web-ready format. Browse to the images 

folder inside the Chapter 4 site, and save 

the file as ronni-edited.png.

Choose the PNG24 
file format from the 
available options

Figure 4.21  The Image Optimization window appears when you 
insert a PSD file in a page.
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In the Property inspector, you’ll see that Dreamweaver is now tracking the 

path and filename of the source image used to create this version (in the area 

marked original) (Figure 4.22). The next time you click the Edit button, the 

PSD file, and not the version that is on the page, will open in Photoshop.

Now look at the image itself. You’ll see a small icon in the upper-left corner of 

the image that indicates this is a version of an image that came from a Photo-

shop source file and is available for round-trip editing.

Round-trip icon

Path and filename  
of source PSD file

Open the source PSD 
file in Photoshop

5	 Click the Edit button in the Property inspector. The PSD file will open in 

Photoshop.

Let’s look at a quick demonstration of how round-trip editing works.

6	 In Photoshop, choose Image > Image Rotation > Flip Canvas Horizontal.  

The cartoon character will rotate to face right instead of left.

7	 Save the PSD file. Return to Dreamweaver.

Everything looks the same. No worries. To see the change you made in 

Photoshop, you have to tell Dreamweaver to update the image.

8	 Click the Update from Original button in the Property inspector 

(Figure 4.23). Alternatively, you can right-click the image and choose Update 

from Original.

The character is now looking to the right, just as she is in the source file.

9	 Save the prototype.html file you’ve been working on. This project is 

complete.

Figure 4.22  Source 
Photoshop files are 
tracked by Dreamweaver.
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Update from 
original source

Alternatively, right-click the image, 
and choose Update from Original

You’ve just learned a lot about how images are inserted into web pages using 

Dreamweaver’s toolset. You’ve also seen how you can use Dreamweaver’s built-in 

image editing tools for making minor corrections to an image and how Dream-

weaver and Photoshop can be used together in the recommended workflow, where 

the designer makes edits to a source PSD file that can be easily updated in Dream-

weaver. Don’t forget to always back up your originals!

Figure 4.23  The Property 
inspector when working 
with a round-trip image
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PROJECT 4.3

Floating Images into Position
You have inserted the images for the home page into your prototype page, but they 

still don’t look like the design comp. The two images are currently resting on the 

baseline of the paragraph that contains them. But you can nudge them to the loca-

tion you want using the CSS float property.

In this project, you’ll float the two images into place. You’ll also learn some of the 

principles of floating images, learn how to set the clear property so that your 

floats behave themselves, and use some Dreamweaver tools that make this type of 

work go more quickly.

Create and Apply a CSS Class Selector
By default, images that are inserted into a web page rest on the baseline of the ele-

ment on which they’ve been placed. When images are inserted into a paragraph, 

the image will set along this invisible line along the same line of text that is adja-

cent to them. The CSS float property is used to disengage the image from the 

baseline and allow the text to flow around the image.

1	 Open prototype.html in Dreamweaver. Make sure the two final versions of 

the cartoon characters—Ray and Ronni—that you inserted in the last project 

are positioned where you want them on the page.

2	 Open the CSS Designer panel. Click the + at the top of the Selectors section, 

as you see in Figure 4.24. Dreamweaver will create a new blank Selector field 

where you can name the selector.

3	 Name the new selector .float-right and press Enter/Return to accept the name.

4	 In the Layout Properties category, click the float-right property button.

You have now created and named a new class selector that can be used over 

and over again within the document.

It’s a good idea to apply a bit of padding to an image so that text doesn’t jam 

up against the side of the image, making the text harder to read.

5	 Click the symbol in the middle of the padding properties section. Set a pad-

ding value of 5 px in one location. Dreamweaver will duplicate the setting to 

the other three sides all at once—slick!

Now you can assign the .float-right property to one of your images.

  ACA Objective 1.5

  ACA Objective 2.3

  ACA Objective 2.4

  ACA Objective 4.1

  ACA Objective 4.3

	Video 4.7   
Floating Images 
into Position

	Video 4.8   
Accessible Images
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Click the + to add  
a new selector

Click to apply 
padding values 
to all four sides

.float-right  
property applied

The new selector is 
listed once a name 
(.float-right, in 
this case) has been 
entered

6	 Select the ronni-edited.png image on the web page.

7	 From the Class dropdown menu in the Property inspector (Figure 4.25), select 

.float-right.

The image floats to the right of its container, and the text flows around the 

image. You can drag the image into different areas of the page, but the image 

will always float to the right of its container no matter where you drop it.

Figure 4.25  Applying a 
float selector to an image

Image floats right, 
and the text flows 
around the image

CSS class assigned 
in the Property 
inspector

Figure 4.24  Adding 
a class selector in the 
CSS Designer panel and 
assigning properties

TIP  
Class selector names 
always begin with a 
dot (.). One way to 
remember this is that 
your classes at school 
are usually divided into 
periods as well—just 
remember that school 
classes have periods 
and so do CSS class 
selectors.
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Duplicate and Apply a CSS Class Selector
You still need a class selector to float an image to the left, but Dreamweaver has a 

nice way to make this process quick and easy. You can duplicate the existing selec-

tor, modify the name, and change the values for the new selector.

1	 Right-click the .float-right selector (in the CSS Designer panel). Select 

Duplicate from the context menu. Dreamweaver makes a copy of the selector, 

and your cursor will be positioned inside the name of the new rule.

2	 Change the name of the new selector to .float-left and press Enter/Return to 

accept the new name.

3	 In the Properties section of the panel, change the float setting to left.

4	 Use the Classes setting in the Property inspector to apply the .float-left 

class to the Ray the Werewolf image. The image floats to the left side of the 

content container.

Modify CSS Float Properties 
and Apply Clear Values
The design is looking good, but the image of Ronni floated to the right is smashed 

up against the right border of the container. You could have an issue with overlap-

ping images when you begin floating more images into place. In the next steps, 

you’ll adjust the padding on the .float-right class and set the clear properties 

that will prevent the floated images from overlapping other elements that have 

been floated.

1	 In the CSS Designer, select the .float-right selector.

2	 In the Properties panel, click the center of the Padding section to unlock the 

settings, and change the right padding setting to 15 px, as in Figure 4.26.

The other settings will remain the same as you change this one value. Setting 

the clear values for each float class is just as easy.

3	 With the .float-right selector still selected, click the both value for the 

clear setting.

4	 Select the .float-left selector, and repeat the process of setting the clear 

value to both.

With both float classes properly set to clear: both, the next image you float 

will position correctly without any overlap.
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Unlock the padding 
settings to change 
individual padding 
values

Set padding right  
to 15 pixels

Set clear value  
to both 

Add Alternative Text to Images
For web pages to be accessible to individuals with vision and other disabilities, web 

page images must always include alternative text. Most US government agencies 

require web pages to meet accessibility standards (it is also the law in other coun-

tries, such as Australia, and in the European Union). It’s also just a good practice to 

follow because the description will display in the event the image doesn’t display 

for some reason. Assistive devices, such as screen readers, will read the alt text to 

an individual who might not be able to see the image clearly. It’s also helpful when 

your site is indexed by search engines. If the image adds meaning to the web page, 

include descriptive alternative text. For example, instead of using “my photo” as 

alternative text, use “photo of me sitting at the beach watching the waves.” One 

gains a much greater understanding of the image contents from the latter text than 

from the former. Adding alt text is usually handled in the Property inspector.

1	 Select the image of Ray.

2	 In the Alt field in the Property inspector (Figure 4.27), type Ray the 

Werewolf in his relaxed pose. Click anywhere on the page to accept 

the value.

Figure 4.26  Modifying 
the .float-right class 
selector and setting the 
clear value
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3	 In the Title field of the Property Inspector, type Ray the Werewolf. Click any-

where on the page to accept this value.

4	 Select the image of Ronni.

5	 In the Alt field, type Ronni the Vampire in her relaxed pose. Click outside 

the field to accept the value.

6	 In the Title field of the Property inspector, type Ronnie the Vampire. Click 

outside the field to accept the value.

See how easy it is to make your pages more accessible?

This project introduced you to the concept of floating images—the process by 

which a CSS rule is applied to an image so that text can flow around the image. You 

now know how to use Dreamweaver to create a new class selector, how to assign 

the properties and values you want to the selector, and even how to duplicate a 

selector to make the design process go a little faster. You’ve also learned about how 

to assign alt text and titles to images so that your work meets accessibility stan-

dards. Another nice piece of work!

Type a meaningful 
description of the image 

into this field

Type a descriptive 
title into this field

Figure 4.27  The Alt text 
field and Title field in the 
Property inspector
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PROJECT 4.4

Creating Structured 
Layouts with Images
In the last two projects, you worked a bit with client-provided artwork to float 

images onto the page. Where there are single images like the ones you’ve used so 

far, inserting images and applying a float to move the graphic into position is rela-

tively easy.

The About Our Staff page features blocks of text with the name and description of 

each character in the comic strip. In the olden days, layouts like this—in which 

an image is aligned and positioned next to a paragraph of text—would have been 

done using tables. Unfortunately, this approach renders such pages inaccessible to 

those using assistive devices (and to many search engine bots). Therefore, this prac-

tice has not been employed by practicing professionals in many years. In the mod-

ern world of web design, designers use more efficient methods that take advantage 

of advances in browser support for CSS. Through reliance on CSS for the style of 

the page, the HTML content remains accessible to those using assistive devices (and 

search engine bots) as well.

Dreamweaver accommodates the kinds of efficient, CSS-based designs that have 

become the industry standard and adds some visualization features that allow 

designers to get things just right.

The Design Challenge
The page that features all the characters from the comic strip should have an image 

of the character, with their name and “bio” alongside the image. The client help-

fully provided all the character images at the same width and height, which will 

make the design work a bit easier.

The challenge for this layout is to maintain the association between the text and 

the image. You might consider inserting the image and using the CSS floats that 

were created in the last project to slide the image into place. The problem with 

this approach is that floated images don’t create a new “break” within the content 

on the page. You would have to insert a number of empty paragraphs by pressing 

Enter/Return over and over until each image appeared next to a line of text and 

had blank areas between each character. Of course, this approach would break as 

soon as the page is viewed on a mobile device with a different screen resolution.

  ACA Objective 1.5

  ACA Objective 2.3

  ACA Objective 4.1

  ACA Objective 4.3

	Video 4.9  Creating 
Structured Layouts 
with Images

	Video 4.10  Rulers 
and Guides
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Alternatively, you might consider inserting a table and placing the images into 

the left column and the text into the right column. Both of these approaches are 

semantically incorrect, difficult to maintain, and just a bad idea.

The better approach is to create a container that holds both the image and the text, 

and then use the power of CSS classes to define the container and all the content 

that applies to each character. The result of this project’s work will have the image 

of each character appear next to its information (Figure 4.28).

Preparing Content for the  
First Character Container
The client provided the name of each character and their bios in the Team Page 

area of prototype.html. With that file open, it’s time to begin.

1	 Place your cursor after the first character’s name (Ray) (after the colon), and 

press Enter/Return to insert a new paragraph. Clean up any extraneous char-

acters (such as deleting the colon) or spaces until your text appears as follows:

Ray

Ray is the originator of…

Figure 4.28  When this 
project is complete, each 
character will have its own 
content box in which to 
display its image and bio.
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2	 Place your cursor in front of Ray’s name, and use the Property inspector to 

assign the Heading 3 format to the character’s name.

3	 In the Assets panel, locate the ray-named.png file, and insert it into the page 

in front of the character’s Heading 3–formatted name.

Inserting a <div> for the Character Content
Now you need to create the container that will hold all the contents for each char-

acter: their image, their name, and their description.

1	 Drag to select the image and all the text associated with Ray (Figure 4.29).

	

2	 Choose Insert > Div in the application bar. The Insert Div dialog appears.

3	 Leave the Insert field in this window set to Wrap Around Selection, and click 

the New CSS Rule button at the bottom of the dialog. The New CSS Rule 

dialog appears.

4	 With the Selector type at the top of the window set to Class, name the new 

rule .characters. Click OK. The CSS Rule Definition dialog appears.

5	 Select the Box category in the Category column, set the float property to 

left and the clear property to both (Figure 4.30), and click OK.

You return to the Insert Div dialog.

Select the Box category
Set the float and clear 

properties as shown

Figure 4.29  The content 
on the page selected and 
prepared for styling

Figure 4.30  The CSS Rule 
Definition dialog for the 
new .characters rule
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6	 Click OK in the Insert Div dialog to complete the process of inserting 

the <div>.

The image and all the text are now contained inside their own container with the 

attribute class="characters". As you recall, when the <div> was inserted, the 

field was set to Wrap Around Selection. Dreamweaver displays this container with a 

dotted line around it when you are in Design view. 

Floating an Image Inside a Container
Now it’s time to style the elements that are contained within this new <div>. Take 

note that these styling rules will use descendent selectors to create styling rules that 

will apply to any content found inside a <div> with the class name .characters 

applied.

1	 Select the image of Ray.

2	 In the CSS Designer panel, click the + in the Selectors section to create a new 

rule based on the item selected on the page.

Dreamweaver will suggest that you name this rule .characters h3 img. 

Do you see how the cascade works? This rule will apply to any image that is 

inside an <h3> tag that is located in a <div> with the .characters class.

But this is a little more specific than you need in this case.

3	 Delete the h3 descendent so that your rule name is .characters img. Don’t 

forget to press Enter/Return.

This rule will now apply to any image found within the .characters <div>.

4	 In the Layout category in the Properties section, set the float property to 

left and the clear property to both (Figure 4.31).

The text that’s associated with Ray jumps up beside the image, just like you 

want. Don’t be too concerned about the position of other characters on the 

page. Once all the containers are in place, things will sort themselves out. You 

can also check in code view to confirm that the image, header, and text are 

contained in the <div> tag.
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Figure 4.31  Settings for 
the .characters img rule

Choose the selector name

Apply float and 
clear properties

Create a Second Character <div>
To see the interplay between two boxes that contain a character, let’s repeat the 

process you just followed for the Ronni character and insert a <div> around that 

area of the page.

1	 Edit the text so that Ronni’s name is on a new line, with her description 

below her name.

2	 Format the character’s name as an <h3>.

3	 Insert the image ronni-named.png to the left of her name.

4	 Select all the text and the image, then choose Insert > Div from the 

application bar or from the Insert panel.
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5	 In the Insert Div dialog, select the existing CSS .characters class from the 

Class dropdown menu (Figure 4.32). Click OK.

The contents of this new <div> snap into place. You now have two content 

boxes that you can use to adjust the styling.

Figure 4.32  You can assign an 
existing CSS class (characters) 
when you insert a new <div>.

Styling the Content Containers
Now that you have two character containers, you can fine-tune the styling proper-

ties for their contents. The beauty of using CSS rules is that once you adjust the 

settings for one container, all the other containers with the same class applied will 

be automatically updated.

1	 In the CSS Designer panel, select the .characters selector, and apply a bor-

der to the box. Make the border 1 pixel wide, with the style set to solid and 

the color set to black (#000000).

You can select the Show Set check box to see only those properties assigned to 

the selector. Your settings should match those in Figure 4.33.

Choose the 
selector name.

Existing float and 
clear properties

New border 
property settings

Figure 4.33  Border  
properties added to  
the .characters selector
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When you switch to Live view, you’ll see that the two containers have no 

space between their respective boxes. Text within the box is too close to the 

image, and the boxes are jammed up against the right side of the page. You’ll 

adjust these settings using the margin and padding properties.

2	 With the .characters rule still selected, deselect the Show Set box to see all 

the properties. In the Layout category of the CSS Designer panel, set the bot-

tom margin of the container to 10 px. This adds space between the two boxes 

and separates them from each other.

3	 Apply a right margin of 15 px. This moves the right edge of the container 

away from the edge of the page.

4	 Apply a right padding of 10 px. This moves the text within the box away 

from the right border of the box.

The final settings for the .characters rule should appear as in Figure 4.34.

The final bit of tweaking needs to take place on the image: adding a bit of 

padding to the image to provide some “air” between the image and the text.

	

Figure 4.34  Final settings 
for the .characters rule
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5	 Select the .characters img rule.

6	 In the Layout category, assign the padding values that you think look best 

for the right, bottom, and left padding properties. This is a great time to 

work in Live view so you can clearly see the changes that you make as they 

are applied.

Aligning Elements with Guides
One of the big advantages to using Dreamweaver to create and style web pages is 

the ability to put visualization tools into place that let you fine-tune your design. 

Guides are horizontal and vertical lines that Dreamweaver displays as you’re work-

ing. You can use these guides to check the alignment of elements on the page.

1	 With your document in Design view, choose View > Design View Options > 

Rulers > Show to display rulers on the top and left side of the document 

window.

2	 Choose View > Design View Options > Guides > Show Guides. With this 

option selected, you can click one of the rulers and drag a guide onto 

the page.

3	 Click the top ruler, and drag to position a guide directly above the first char-

acter’s name. If you’re having problems getting the guide into just the right 

place, deselect both View > Design View Options > Guides > Snap to Guides 

and View > Design View Options > Guides > Guides Snap to Elements.

As you can see in Figure 4.35, the image isn’t perfectly aligned with the text. 

But you can fix that easily enough.

	

Rules appear on the left and top 
of the Document window

Drag guides onto the page 
to check alignments

Figure 4.35  Rulers and 
guides allow you to 
check alignment of page 
elements.
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4	 In the CSS Designer panel, select the .characters img rule, and adjust the 

top padding property to push the image down until it perfectly aligns with 

the character’s name. Top padding should now be 6 pixels.

5	 Drag a guide from the left ruler and position it in line with the right border of 

the character box.

As you scan up the page, you’ll be able to see whether everything falls into 

alignment with this guide. Everything looks good in your character boxes, but 

the text in the paragraphs contained in the #content <div> are not in line 

with the borders of the character containers.

6	 Click anywhere in the first line of the introductory text on the page, then 

click the + in the Selectors section of the CSS Designer panel. Dreamweaver 

will suggest that this rule be named #container #content p.

7	 Press the Up Arrow key on your keyboard to make this rule a little less spe-

cific. The actual name you’re after here is #content p, which is specific 

enough for your purposes.

8	 Apply a right padding setting to this rule until the text in this paragraph and 

in others on the page is aligned with the guide. Right padding should now be 

12 pixels for this rule.

9	 Save your page, and preview it in two of your favorite browsers. Look for 

alignment issues that need to be addressed and return to Dreamweaver to 

make adjustments to the styling rules you’ve just created. Since different 

browsers use different layout engines, it is important to examine your work in 

a minimum of two different browsers.

Completing the Character Page Listing
You’re almost finished with this project; you have just one more task to complete. 

Following the same steps you used to get the Ray and Ronni character containers 

constructed, you need to edit the text, apply a Heading 3 to the character’s name, 

and then insert the character’s image next to the name. You’ll then wrap the char-

acter’s contents into a new <div> and assign the .characters class. As you com-

plete each container, the styling rules you’ve created will be applied to the contents, 

and before long all the employees of WULVS will have their own neatly aligned 

listing on the page.
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PROJECT 4.5

Styling the Header Area
From the client feedback document you reviewed, you know that the final design 

needs to feature some of the characters from the comic strip at the top of the page 

in the header area. That’s going to be a relatively easy task to accomplish since you 

can use CSS floats and a couple of collage images that the client has provided.

While you’re styling this area, you should tend to some other matters as well. In 

this project, you’ll insert and float the images into the header area, add links to the 

home page of the site, and use a web font to style the name of the company.

LEVEL UP: YOUR DREAMWEAVER SKILLS

Throughout this book, you’ve seen lots of detailed instructions on how 
to apply settings and where to find the different working areas of Dream-
weaver’s user interface. But now it’s time for you to build your confidence in 
using the application by following the steps provided for this project without 
a great deal of extra instruction. You can follow along with the videos, of 
course, but at this point I’m confident that you’re capable of doing more 
on your own. You’ll be more confident too if you endeavor to do more and 
more on your own as you go forward.

Inserting and Floating the Header Images
Your client has provided new images that he wants to include at the top of the page 

to the left and right of the company name. In the following steps, you’ll insert 

these images into the header area of the page and then place them into position. 

Keep in mind these techniques apply only to fixed designs for a desktop or laptop 

computer. We will learn about making the site responsive for mobile devices in a 

subsequent chapter. One step at a time, grasshopper.

The header area will need some additional room for the images to fit within the 

container. So let’s do that first.

1	 In the CSS Designer panel, choose the #header selector, and set the 

height in the Layout category to 136 pixels. You’re now ready to insert the 

collage images.

  ACA Objective 1.3

  ACA Objective 1.5

  ACA Objective 4.1

  ACA Objective 4.2

  ACA Objective 4.3

	Video 4.11   
Part 1: Styling the 
Header Area

	Video 4.12   
Part 2: Styling the 
Header Area
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2	 Place your cursor in front of the first letter in the first line of text in the 

header area.

3	 Using the Assets panel, insert the images header-collage-left.png and 

header-collage-right.png. These images will be floated, so you can 

just place them side by side. Name the images in the Alt field of the Prop-

erty inspector. For the header-collage-left.png image, I recommend 

alternative text of “Our team includes: AI the Alien, Robbie, The Twins, 

Vladimir, and Ronni.” For the title, I recommend the text “The first half 

of our team.” You decide on appropriate alternative text and title for the 

header-collage-right.png image. 

4	 Select header-collage-left.png, and assign the float-left class to the 

image in the Property inspector. The image snaps into place on the left side of 

the header.

5	 Select header-collage-right.png, and assign the float-right class to 

the image.

This time the image isn’t positioned properly; it falls outside the header. That’s 

not good, but more than likely the issue has to do with the clear: both 

property that is assigned to this rule. Since you don’t want to change the 

existing float-right class that’s in use in other parts of the design, you 

need a new rule for this image.

6	 Right-click the .float-right rule in the Selectors area of the CSS Designer 

panel. Select Duplicate.

7	 Change the name of the rule to .float-right-header.

8	 In the Layout category of the CSS Designer, change the clear value for this 

rule from clear: both to clear: right. This change allows the image to 

properly float into place within the header.

9	 Select header-collage-right.png, and assign the float-right-header 

class to the image. The image snaps into place.

WARNING  
A word of caution is appropriate at this point. It is easy to duplicate classes 
and include slight modifications to achieve desired results in a web page. 
Make certain you understand the underlying CSS rules so that you don’t 
end up creating a large number of classes to accomplish specific styling. 
This is often called classitis and is to be avoided as much as possible. If you 
end up with scores of classes on your page with only a few differences in 
each class, rethink how you are applying your CSS styles.
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Adding Links in the Header
It’s common—even expected—for a visitor to a website to be able to click the 

header at the top of the page and go to the site’s home page. You’ll add links to 

the two images and to the company name to make this possible. Later, when this 

prototype is converted into a template, the links will be in place and ready to go.

1	 Click the header-collage-left.png image. In the Property inspector Link 

field, enter the filename of the home page: index.html.

2	 Click the header-collage-right.png image. Also link this image to the 

index.html home page.

3	 Select the name of the company in the center of the header area on the page. 

Also link the selected text to the index.html home page.

Removing Default Styles from Text Links
Text links by default have always been shown in blue, underlined text. This obvi-

ously won’t work for the design the client is after, so you’ll remove those properties 

from the <a> tag with a new CSS styling rule.

1	 Place your cursor anywhere within the company name in the header.

2	 Click the + in the Selectors area of the CSS Designer panel. Press the  

Up Arrow key once so that the new selector name is set as #header-name a.  

Press Enter/Return to accept the name.

3	 In the Text category, set the text color to black and text-decoration to none. 

Looking at the CSS you just wrote, you should see the following code block:

#header-name a {

	 color: #000000;

	 text-decoration: none;

}

Styling the Company Name with Fonts
The client asked for some “weird- or scary-looking” text for the company name. 

To get text that goes beyond the common fonts that are standard across browsers, 

you can use Adobe Edge Web Fonts, which is a free service, to find more interest-

ing fonts to work with. This is a library of fonts that is served by Adobe Typekit 

and can be freely used on your website. Remember that fonts are covered by copy-

rights. Only use fonts that you are certain can be freely used on your website. By 
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relying on fonts served from Adobe Edge Web Fonts, you don’t have to worry about 

this issue.

The company name in this document already has a rule applied to which you can 

easily add additional properties and values to make the name “weird or scary.”

1	 Select the header-name rule in the Selectors area of the CSS Designer panel.

2	 Set the text color to black (#000000).

3	 Click inside the font-family field. From the 

menu that appears, select Manage Fonts.

Adobe Edge Fonts are free font packages that 

will be loaded into the page with a little snip-

pet of JavaScript that is inserted into the 

<head> of the document. The Manage Fonts 

dialog you see in Figure 4.36 allows you to 

choose one of these fonts to use in your page.

4	 Select the font Amatic-sc or try out another 

font that you like. Click Done to load the font 

into your library.

Once you load a font into your library, you can 

assign the font as a property. 

5	 Click inside the font-family field, and select 

the Amatic-sc font (or whichever font you 

loaded) for this rule.

6	 Switch to Live view to see the appearance of 

the text. Adobe Edge Web fonts display prop-

erly only in Live view.

7	 Return to Design view. Use the font-size and font-weight settings for this rule 

to make the text appear the way you like. I recommend trying to keep all text 

on one line, but this will depend on your screen resolution. For this example, 

your styling rule might appear as follows:

#header-name {

	 margin-top: 0px;

	 color: #000000;

	 font-family: amatic-sc;

	 font-weight: 700;

	 font-size: 36px;

}

Figure 4.36  Adobe Edge Fonts can be selected from this 
window and loaded into a font library on your computer.

Chapter 4  Getting the Big Picture  151



Styling the Company Tagline
One more job to take care of. You need to style and position the tagline that falls 

below the company name. Here’s the styling rule that was created to get this done 

in the video demonstration:

#header-tagline {

	 margin-bottom: 0px;

	 color: #1B1B1B;

	� font-family: "Gill Sans", "Gill Sans MT", "Myriad Pro",  
"DejaVu Sans Condensed", Helvetica, Arial, sans-serif;

	 font-style: italic;

	 font-size: 14px;

	 margin-top: -36px;

}

Can you figure out where to apply these settings in the CSS Designer panel?

In this project you’ve taken another step in becoming proficient with Dreamweaver 

by diving in on your own to insert images and links and apply styling to the header 

of the page. Another job well done! Do you feel your confidence rising?
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Challenge! Create Your Own 
Design with Photoshop
As you’ve worked through the material in this chapter you’ve no doubt thought of 

lots of ways that this design might be done. The client provided only some general 

guidance, and the examples you’ve seen here took off in sort of a hipster-look direc-

tion. But you’re heartily encouraged to do better by creating your own design.

To help get you started, the project folder for this chapter has two files in the 

source folder that you can use to create your own design comps. You’ll find a file 

for Photoshop (wulvs-layout.psd). This file is already organized into layers that 

match the dimensions used in developing this prototype. It’s up to you to open 

this file and use your own creative ideas to make a totally new design.

Conclusion
Although the title of this chapter is “Getting the Big Picture,” it might as well have 

been named “Working with Backgrounds, Inserted Images, Named CSS Class Rules, 

and Dreamweaver Visualization Techniques.” Well, that’s a little long, but that’s 

just what you’ve accomplished as you’ve worked through these projects.

Along the way to learning how to use Dreamweaver to include the visual elements 

that images provide, you’ve also learned more about the principles of web design, 

how CSS styling rules are used to position elements on a page, and even how to 

style text using CSS and fonts that are located on a web service.

And the great news is that your design work is nearly complete. In the next chapter, 

you’ll work to get the final elements of this design wrapped up as you learn how to 

style navigation bars, tables, and more.
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application bar, 48
Apply Source Formatting command, 189
apps, developing mobile, 256
aspect ratio, 127
assets folder, 202
Assets panel, 64–65

functional areas of, 64, 65
inserting images using, 126, 149, 161–162
library items in, 212, 213–214, 215

assistive devices, 177
attributes, 12, 30

B
backgrounds

color setting for, 99, 168
gradients used in, 121, 122, 123–124
images used in, 119–122

backing up files, 116
bitmaps, 112
<blockquote> tag, 55
<body> tag, 10, 29, 30, 99
Bootstrap, 227

components in Dreamweaver, 238–239
creating new pages using, 237–238
description of jQuery and, 236
Live view for working with, 240
overriding settings of, 242–244

borders, 144
box model, 51, 98
<br> tag, 86
Brightness tool, 130
Browse for File button, 40, 234
browsers. See web browsers
.btn selector, 242, 243
bullet symbols, 167

Index

A
<a> tag, 11, 12, 30, 169
about this book, viii–ix
ACA exam objectives, ix
accessibility information

checking for missing, 190
for images, 137–138
for tables, 176–177

accessibility standards, 137
Adobe Add-ons, xiii
Adobe Animate, 249
Adobe Application Manager, xii
Adobe Certified Associate (ACA) credential, xiv
Adobe Certified Associate (ACA) Exam, ix
Adobe Dreamweaver CC. See Dreamweaver
Adobe Edge Web Fonts, 150–151
Adobe Flash Player, 226
Adobe Forums, xiii
Adobe Media Encoder, 246
Adobe PhoneGap service, 256
Adobe Photoshop. See Photoshop
Adobe Typekit, 150
advertising block, 185–186, 210
aligning elements, 146–147
alternate attribute, 32
alternative text, 58–59

adding to images, 137–138
See also accessibility information

animations, 249–256
containers styled for, 250–252
information box text for, 252
page and container creation for, 249–250
styling with CSS transitions, 253–256
See also video

Appearance settings, 82
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colored, 32, 33, 64, 65
comparing, 208
validating, 35–36
viewing, 27–28

code font, x–xi
code hints, 65
Code Navigator, 66
Code view, 27, 48
Coding toolbar, 200
coding tools, 65–66
collapsing code, 66, 95
color

background, 99, 168
caution on using, 14
sampling from images, 168
text, 13

colored code, 32, 33, 64, 65
columns

faux styling of, 117–118
indicator for rows and, 53
table width values for, 175
See also rows

comments, 200
company name styling, 150–151
company tagline styling, 152
comparing code, 208
comps, design, 91, 92, 106
containers

card, 250–251
content, 91–96, 144–146
floating images inside, 142–143
image, 251
information box, 252

Contrast tool, 130
conventions used in book, x
Creative Cloud desktop application, xii
Crop Image tool, 130
CSS (Cascading Style Sheets), 7

animation styling, 253–256
class selectors, 134–136
elemental properties, 81–83
float property, 134–137
gradients, 123, 124
media queries, 52

C
card container, 250–251
Cascading Style Sheets. See CSS
challenge projects

creating page comps, 106
customizing the starter page, 37–40
designing with Photoshop, 153
testing your new skills, 257

.characters rule, 144–146
Check In/Check Out options, 52, 63
child selectors, 175, 196
Chris the Cartoonist project

client resources, 78–79
content containers, 91, 93–96
described, 70, 110, 156
design process, 77–78
hyperlinks, 89–90
page properties, 79–83
planning process, 72–74
project files, 71, 110, 156
setting up, 71, 111, 156
site structure, 74–76
text formats, 84–88
wireframes, 91–93

Chrome browser, 81, 190, 244
class attribute, 12
class selectors, 31, 196

creating and applying, 134–135
duplicating and applying, 136
name convention for, 135

classes, 30
caution on overusing, 149
IDs distinguished from, 95

cleaning up
code on web pages, 189–190
tables from Word, 172–174
web page designs, 188

Clear Column Widths button, 173
clear property, 134, 136–137
client computer, 6
client feedback, 113–115
code

cleaning up, 189–190
collapsing, 66, 95
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Document window, 47, 48–54
document tabs, 48
document type indicator, 54
error checker, 54
features illustration, 49
File Management button, 52
Inspect mode, 51
Live view options, 52
Media Queries button, 52
Open Documents button, 52
Real-time Preview option, 52–53
row/column indicator, 53
tag selector, 54
view switcher, 48–51
Window size option, 53

DOM (Document Object Model), 8, 29
DOM panel, 29
domain name server, 6
domain names, 6
Dreamweaver

coding tools, 65–66
historical origin of, 16
installing, xi
operating system differences, xi
preference settings, xiv, 125
resources, xiii–xiv
software updates, xii
templates, 203–209
unique features, 44
workspace overview, 46–48

dropdown menus, 181–182
duplicating images, 128–129
dynamic websites, 17

E
eBook edition of book, ix, xii–xiii
Edge Web Fonts, 150–151
Edit Rule button, 56
Edit Transition dialog, 254
editable regions

adding optional, 210–211
inserting into templates, 204–205

editing images, 59, 130, 131–133

new standards introduced for, 226–227
positioning elements with, 97–105
Property inspector for, 56–57
reviewing syntax for, 195–196
styling rules, 12–14, 30–32, 124, 195, 199
See also custom CSS files

CSS3
exploring animations using, 249–256
new standards introduced with, 226–227

CSS box model, 51, 98
CSS Designer panel, 34, 57, 61–62

Background settings in, 118, 119
media queries displayed in, 233
positioning elements with, 98–105, 162–163
setting shorthand notations in, 198
Show Set option, 34, 62, 144

CSS Rule Definition dialog, 141
CSS Transitions panel, 253, 254
custom CSS files, 241–244

applying override settings in, 242–244
steps for creating, 241–242

custom font stacks, 187–188
customizing

starter page, 37–40
workspace, 60–61

D
database, 17
default home page, 17
dependent files, 218
descendent selectors, 32, 101, 196
design cleanup, 188
design comps, 91, 92, 106
design process, 77–78
Design view, 34, 49–50
<div> tag, 11, 29, 91

inserting, 93–96, 141–142, 143–144
styling, 100–103, 250

Document Object Model (DOM), 8, 29
document tabs, 48
Document toolbar, 52, 65
document tree, 29
document type, 10, 54
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fluid design. See responsive design
folders

organizing websites into, 18–19
rules for naming, 19
source files stored in, 130

font weight, 56
fonts, 50

company name styled with, 150–151
CSS styling properties for, 56
fixing on web pages, 187–188
for indicating code, x–xi
setting formats for, 84
web, 187

footers
links in, 104–105
styling, 102–103

<form> tag, 180
forms, 178–184

adding function to, 182–183
dropdown menu added to, 181–182
inserting text from Word into, 179–180
styling process for, 183–184
text fields for, 180–181

forums, Adobe, xiii
framework, 227
FTP (File Transfer Protocol), 62

G
gaps, margin, 103–104
GIF image files, 111
Go to Code option, 169
Google Chrome browser, 81, 190, 244
gradients, background, 121, 122, 123–124
graphic design, 76
group selectors, 196
guides, 146–147

H
<h1> tag, 10, 30
H.264 video encoding, 246
head, page, 10
<head> tag, 10, 29

editors
image, 125
text, 9
visual, 16

educator resources, xiv
element selectors, 82, 196
element styles, 30
elemental CSS properties, 81–83
<em> tag, 180
encoding, 246
error indicator, 54, 189
external CSS file, 51
external style sheets, 195
Eyedropper tool, 168

F
faux column technique, 116–118
file extensions, 17
file formats

for images, 111–112
for video, 245, 246

File Management button, 52
file management method, 130
File Transfer Protocol (FTP), 62
file weight, 112
filenames, 19, 80
files

backing up, 116
dependent, 218
image, 111
project, 23
related, 51, 202
synchronizing, 220–221

Files panel, 25, 62–63, 75, 128, 218–219
Find and Replace dialog, 173
Firefox browser, 81, 190, 244
fixed-width designs, 160
Flash Player, 226
Flick, Chris, 70
float property, 134–137
floating images, 32

header area, 148–149
inside containers, 142–143
positioning by, 134–137
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editing tools for, 59, 130
file formats for web, 111–112
floating, 134–138, 142–143
header area, 148–149
inserting, 126, 148–149, 161–162
listed in Assets panel, 64
optimization of, 112, 131
Photoshop edits of, 59, 131–133
Property inspector for, 58–59, 127
replacing on web pages, 40, 158–159
sampling colors from, 168
scaling and sizing, 58, 126–128, 129
structured layouts with, 139–147
tiling of background, 120–121

<img> tag, 11, 30, 162, 251
incremental backups, 116
Indent settings, 55
index home page, 17
information architecture, 74
information box container, 252
inline styles, 57, 195
Insert button, 64
Insert Div dialog, 141, 144
Insert Navigation dialog, 166, 167
Insert panel, 94, 166, 211
inserting

<div> tags, 93–96, 141–142, 143–144
editable regions, 204–205
HTML5 video, 246–248
images, 126, 148–149, 161–162
library items, 215
<nav> tags, 166–167
text from Word, 179–180

installing Dreamweaver, xi
interactive forms. See forms
internal style sheets, 30, 195
Internet

diagram of connections on, 6
World Wide Web distinguished from, 4

Internet Explorer browser, 190
Internet Protocol (IP), 6
IP addresses, 6
iPhone, 53, 225–226, 256

See also mobile devices

headers
adding links in, 150
inserting and floating images in, 148–149
styling, 101–102, 148–152

headings, table, 175
Help & Support resources, xiii
hexadecimal code, 64
hints, code, 65
home page creation, 206–207
hover values, 170–171, 255
href value, 90
HTML (Hypertext Markup Language), 7, 8–10

new standards introduced for, 226–227
Property inspector for, 54–55

HTML5, 11
inserting video using, 245–248
new standards introduced with, 226–227

<html> tag, 9, 10
HTTP (Hypertext Transfer Protocol), 5
hyperlinks, 4

adding, 164–165
changing, 38–39
creating, 89–90
footer, 104–105
header, 150
mailto:, 179
setting values for, 169–170
text, 150

Hypertext Markup Language. See HTML
Hypertext Transfer Protocol (HTTP), 5

I
ID attribute, 55, 95
ID selectors, 196
<iframe> tag, 246
image container, 251
image editors, 125
image maps, 59
Image Optimization window, 131
images

alternative text added to, 137–138
backgrounds using, 119–122
duplicating, 128–129
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M
Mac computers, xi, 230
mailto: link, 179
Manage Fonts dialog, 151, 187
Manage Sites dialog, 216, 217
margins

fixing gaps from, 103–104
modifying the settings for, 159–160, 167–168
setting with CSS, 81–82, 100

media
listed in Assets panel, 64
Property inspector for, 59
See also animations; video

Media Encoder, 246
media queries, 52, 61

examining HTML5 tags and, 232–233
JQuery components distinguished from, 239
responsive design using, 227, 232–233
width settings for, 241

Media Queries bar, 52
Media Queries button, 52
Media Query toolbar, 231, 241
metadata value, 247
Microsoft Edge browser, 190, 244
Microsoft Word

cleaning up tables from, 172–174
inserting form text from, 179–180

mobile design, 227
mobile devices

app development for, 256
new standards to accommodate, 226–227
See also responsive design

mock-ups, 76
Move to External Style Sheet dialog, 201
Mozilla Firefox, 81, 190, 244
MP4 video format, 245, 246

N
naming

rules for, 19
starter page, 37
websites, 25

<nav> tag, 166–167

J
JavaScript, 7–8
JavaScript library, 227, 236
JPEG image files, 111
jQuery

components in Dreamweaver, 238–239
description of Bootstrap and, 236

jQuery Mobile, 227

K
keyboard shortcuts

for copying/pasting text, 80
for opening documents, 9
for selecting all content, 94

L
<label> tag, 181
lang attribute, 10, 12
layouts

structured, 139–147
workspace, 25, 60

LBI file type, 213
learning objectives, viii
lesson files, xii–xiii
<li> tag, 85, 88
Library assets, 65
library items, 210–215

converting content into, 211–213
creating from scratch, 213–214
inserting and updating, 215

links. See hyperlinks
linting technology, 189
List Values dialog, 181
lists, unordered, 55, 84–85
Live view, 34

Assets panel in, 65
Design view vs., 49–50
display options for, 52
modifying Bootstrap properties using, 240
responsive design and, 230–232

LoVe HAte mnemonic, 169, 170, 171
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DOM, 29
Files, 25, 62–63, 75, 128, 218–219
Insert, 94, 166, 211
Page Properties, 38, 80
Snippets, 237

paragraph <p> tag, 10, 30, 86, 87
paragraph style, 13
path, file, 19, 58
Pencil icon, 254
personal portfolio page, 235
PhoneGap service, 256
Photoshop

creating your design with, 153
editing images in, 59, 131–133

planning process, 72–74
PNG image files, 112
Point to File icon, 89
positioning

images, 162–163
page elements, 97–105

preferences
resetting to default, xiv
setting individual, 125

Preview in Browser button, 101, 190
Preview on Device option, 53
previewing

assets in Asset panel, 64
web pages in browsers, 34, 52–53, 118, 190

project creep, 228
project files, 23
project folder, 22
Property inspector, 32, 33, 48, 54–59

for images, 58–59, 127, 133
for tables, 59, 173
for text in CSS mode, 56–57
for text in HTML mode, 54–55
for video, 247
views available in, 59

protocol, 5
prototypes

finalizing for production, 185–190
inspecting the current, 157–158
responsive design page, 233–235
working with technical, 115

navigation elements, 164–171
background color for, 168
bullet removal for, 167
hover values for, 170–171
links as, 38–39, 164–165, 169–170
margin settings for, 167–168
navigation tags for, 166–167
pseudo-class selectors for, 169–171

navigation sidebar, 157–163
examining requirements for, 157
inserting images into, 161–162
margin settings for, 159–160
outside in styling of, 158–159
positioning images in, 162–163

navigation tags, 166–167
New CSS Rule dialog, 166
New Document dialog, 206, 229, 237
New Page dialog, 235
New Transition dialog, 253

O
Ogg Vorbis video format, 245, 246
<ol> tag, 55
Open Documents button, 52
operating system differences, xi
optimization process, 112
optional regions, 210–211
ordered lists, 55

P
<p> tag, 10, 30, 86, 87
padding, 32, 134, 147, 243
page comps, 106
page inspectors, 244
Page Properties dialog, 79, 82
Page Properties panel, 38, 80
page titles, 38, 80, 207
panel groups, 48, 60–61
panels

Assets, 64–65, 126, 161–162, 213, 214
CSS Designer, 34, 56, 57, 61–62, 98–105
CSS Transitions, 253
customizing, 60–61
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pseudo-class selectors, 196
hover values set with, 170–171
link values set with, 169–170
mnemonic for order of, 169, 170, 171

publishing to remote server, 218–219

Q
QR codes, 53
Quick Start options, 24

R
Real-time Preview option, 34, 52–53, 120
related files, 51, 202
Related Files toolbar, 202
remote server, 216–221

publishing to, 218–219
steps for defining, 216–217
synchronizing your files with, 220–221
updating files on, 219–220

rendering engines, 81
Reports dialog, 190
Resample Image tool, 130
Reset to Original Size button, 129
resetting preferences, xiv
resources, xiii–xiv
responsive design, 227, 228–244

client requirements for, 228
creating a new page with, 229–230
examining the Live View of, 230–232
exploring with jQuery and Bootstrap, 236–244
media queries used for, 227, 232–233
prototype page with, 233–235

RGB code, 64
rollover effect, 170
root folder, 17–18
round-trip editing, 59, 131–133
rows

indicator for columns and, 53
styling alternate, 175–176
See also columns

Rule Definition dialog, 56, 57

rulers, 146–147
rules

CSS styling, 12–14, 30–32, 124, 195, 199
file/folder naming, 19

S
Safari browser, 190, 244
sampling colors, 168
Save All command, 220
Save As dialog, 35, 37
Save As Template dialog, 203
Save Style Sheet File As dialog, 201
scaling images, 126–128
scripts, 65
search engine bots, 32
search function, 235
selectors

child, 175, 196
class, 31, 134–136, 196
descendent, 32, 101, 196
element, 82, 196
group, 196
ID, 196
organizing, 199
pseudo-class, 169–171, 196
tag, 54, 162
types of, 196

semantic structure, 84
server, 6

publishing your files to, 216–219
synchronizing your files with, 220–221
updating files on, 219–220
See also remote server

Sharpen tool, 130
shorthand notations, 197–198
Show Set option, 34, 62, 144
sidebar

faux column technique for, 116–118
inserting images into, 161–162
margin settings for, 159–160
outside in styling of, 158–159
positioning images in, 162–163

Site menu, 45
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T
<table> tag, 11, 172, 177
tables, 172–177

cleaning up from Word, 172–174
column width values for, 175
headings created for, 175
making accessible, 176–177
Property inspector for, 59, 173
reason for using, 172
setting properties for, 174
styling alternate rows in, 175–176
tags for defining, 59, 172

tag selector, 54, 162
tagline styling, 152
tags

HTML, 8–12
navigation, 166–167
table, 59, 172
See also specific tags

targeted rules, 56, 253
<td> tag, 172, 174
team page creation, 207–208
templates, 203–209

creating, 203–204
description of, 203
editable regions in, 204–205
listed in Assets panel, 65
web page creation from, 206–209

Templates folder, 204
text

adding to images, 137–138
alternative, 58–59, 137–138
color added to, 13
formatting, 84–88
inserting from Word, 179–180
marking up vs. styling, 85

text editors, 9
text fields, 180–181
text format, 84–85
text links, 150
<th> tag, 172, 174, 175
tiled images, 120

site reports, 189
Site Setup dialog, 24, 45, 216–217
sitemap, 74
sizing images, 58, 126–128, 129
Snippets panel, 237
Source Code button, 202
spelling checker, 189
Split view, 27, 48
static websites, 16
<strong> tag, 180
structured data. See tables
structured layouts, 139–147

<div> inserted for, 141–142
design challenge of, 139–140
preparing content for, 140–141

<style> tag, 29, 99, 250
style sheets

comments added to, 200
converting to external CSS file, 201–202
shorthand notations for, 197–198
source order of, 198–199
types of, 195
See also CSS

styling
company name, 150–151
content containers, 144–146
<div> tags, 100–103, 250
footers, 102–103
forms, 183–184
headers, 101–102, 148–152
navigation elements, 164–171
paragraphs, 13
sidebars, 116–118, 158–159
tables, 172–177
taglines, 152
text, 13, 85

synchronizing files, 220–221
syntax

coding language, 7
reviewing CSS, 195–196
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W
W3C validator, 35, 36
wallpaper effect, 119
web browsers

historical origin of, 4
mobile devices and, 226
page inspectors included in, 244
previewing web pages in, 34, 52–53, 118, 190
rendering engines for, 81

Web Edition of book, ix, xii–xiii
web fonts, 187
web pages

customizing, 37–40
design cleanup for, 188
examining properties of, 29–35
previewing in browsers, 34, 52–53, 118, 190
replacing images on, 40, 158–159
reviewing fonts on, 187–188
rulers and guides for, 146–147
templates for creating, 206–209
viewing code in, 27–28

web server. See remote server
WebM video format, 245, 246
websites, 22

change as constant for, 193
site definition for, 23–25, 45–46
static vs. dynamic, 16–17
structure of, 16–19, 74–76

Welcome screen, 23
Window size option, 53
Windows computers, xi
wireframes, 91–93
Word documents. See Microsoft Word
workspace, 46–66

customizing, 60–61
Document window, 48–54
overview of elements in, 46–48
panels and panel groups, 60–66
Property inspector, 54–59

workspace layout, 25, 60
World Wide Web (web), 4
World Wide Web Consortium (W3C), 10, 226
WYSIWYG web editors, 16

<title> tag, 10, 29
title attribute, 59
titles

link, 55
page, 38, 80, 207

tools
coding, 65–66
image editing, 59

<tr> tag, 172
transitions, CSS, 253–256

U
<ul> tag, 31, 55, 84–85
unordered lists, 55, 84–85
Update Files dialog, 230
updating

Adobe software, xii
files on remote server, 219–220
library items, 215

URLs, 39, 64
usability, 74
user experience, 78
user interface, 46–66

Document window, 48–54
overview of elements in, 46–48
panels and panel groups, 60–66
Property inspector, 54–59

V
validating code, 35–36
video

asset examination, 245–246
inserting HTML5, 246–248
See also animations

<video> tag, 245, 247
View menu, 28
view switcher, 48–51
views

Property inspector, 59
switching between, 48–51

visual editors, 16
visualization tools, 96
VLC Media Player, 246
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